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Important Information

Warranty
The serial hardware is warranted against defects in materials and workmanship for a period of two years from the date of
shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace
equipment that proves to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by
receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not
execute programming instructions if National Instruments receives notice of such defects during the warranty period.
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of
the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of
returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully reviewed
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR
IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR
NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT
THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability
of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any
action against National Instruments must be brought within one year after the cause of action accrues. National Instruments
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein
does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National
Instruments installation, operation, or maintenance instructions; owner’s modification of the product; owner’s abuse,
misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside
reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical,
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without
the prior written consent of National Instruments Corporation.

Trademarks
LabVIEW


 and natinst.com  are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliability
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving medical or
clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part of the user
or application designer. Any use or application of National Instruments products for or involving medical or clinical
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeguards,
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should always
continue to be used when National Instruments products are being used. National Instruments products are NOT intended
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard human health
and safety in medical or clinical treatment.



FCC/DOC Radio Frequency

Interference Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict
accordance with the instructions in this manual, may cause interference to radio and television reception.
Classification requirements are the same for the Federal Communications Commission (FCC) and the
Canadian Department of Communications (DOC). The FCC/DOC classification is indicated on a label on
the devices. Look at the product to determine if your equipment has been tested and found to comply with
Class A or Class B, then read the appropriate information below regarding the compliance of your
product:

Class A

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel
brouilleur du Canada.

Class B

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.

• Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel
brouilleur du Canada.



FCC Notices to User
Changes or modifications not expressly approved by National Instruments could void the user’s
authority to operate the equipment under the FCC Rules.

This device complies with the FCC rules only if used with shielded interface cables of suitable quality
and construction. National Instruments used such cables to test this device and provides them for sale
to the user. The use of inferior or nonshielded interface cables could void the user's authority to
operate the equipment under the FCC rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home

Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government
Printing Office, Washington, DC 20402.
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About

This

Manual

This manual contains instructions to help you install and configure the

National Instruments serial hardware and the NI Serial software for

Windows NT. The serial hardware covered by this manual includes the

AT-232/2, AT-232/4, AT-485/2, AT-485/4, PCMCIA-232,

PCMCIA-232/2, PCMCIA-485, and PCMCIA-485/2. This manual

assumes that you are already familiar with Windows NT.

Organization of This Manual

• Chapter 1, Introduction, explains how to use this manual, lists what

you need to get started and optional equipment you can order, and

briefly describes the serial hardware and the NI Serial software.

• Chapter 2, Installation and Verification, contains instructions to help

you install the serial hardware, NI Serial software, and cables.

• Chapter 3, Configuration, contains instructions to help you view or

change the communication port settings.

• Chapter 4, Using Your Serial Hardware, describes how to set the

hardware transceiver control mode for your RS-485 interfaces and

lists some general programming requirements.

• Appendix A, Specifications, describes the characteristics of the serial

hardware and the NI Serial software, along with the recommended

operating conditions.

• Appendix B, Serial Port Information, discusses the RS-232, RS-422,

and RS-485 standards and explains some of the issues involved with

these types of serial communication.

• Appendix C, Uninstalling the Serial Hardware and Software,

explains how to uninstall your serial hardware and the NI Serial

software.
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• Appendix D, Troubleshooting and Common Questions, describes

how to troubleshoot problems and answers some common questions.

• Appendix E, Customer Communication, contains forms you can use

to request help from National Instruments or to comment on our

products and manuals.

• The Glossary contains an alphabetical list and description of terms

used in this manual, including abbreviations, acronyms, metric

prefixes, mnemonics, and symbols.

Conventions Used in This Manual

The following conventions are used in this manual.

» The » symbol leads you through nested menu items and dialog box

options to a final action. The sequence File»Page Setup»Options»

Substitute Fonts directs you to pull down the File menu, select the

Page Setup item, select Options, and finally select the Substitute Fonts

options from the last dialog box.

bold Bold text denotes the names of menus, menu items, parameters, dialog

boxes, or dialog box buttons or options.

bold italic Bold italic text denotes a note, caution, or warning.

bold monospace Bold text in this font denotes the messages and responses that the

computer automatically prints to the screen.

italic Italic text denotes emphasis, a cross reference, or an introduction to a key

concept.

italic monospace Italic text in this font denotes that you must supply the appropriate words

or values in the place of these items.

monospace Text in this font denotes text or characters that you should literally enter

from the keyboard, sections of code, programming examples, and syntax

examples. This font is also used for the proper names of disk drives,

paths, directories, programs, subprograms, subroutines, device names,

functions, operations, variables, filenames and extensions, and for

statements and comments taken from programs.

The Glossary lists abbreviations, acronyms, metric prefixes, mnemonics,

symbols, and terms.
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Related Documentation

The following documents contain information that you may find helpful

as you read this manual:

• ANSI/EIA-232-D Standard, Interface Between Data Terminal

Equipment and Data Circuit-Terminating Equipment Employing

Serial Binary Data Interchange

• EIA/RS-422-A Standard, Electrical Characteristics of Balanced

Voltage Digital Interface Circuits

• EIA-485 Standard, Standard for Electrical Characteristics of

Generators and Receivers for Use in Balanced Digital Multipoint

Systems

• Microsoft Win32 Software Developer Kit, Online Documentation for

Win32 Overviews, Win32 Reference, and Microsoft Windows NT

System Guide, Microsoft Corporation

• NS16550AF Universal Asynchronous Receiver/Transmitter with

FIFOs, National Semiconductor

Customer Communication

National Instruments wants to receive your comments on our products

and manuals. We are interested in the applications you develop with our

products, and we want to help if you have problems with them. To

make it easy for you to contact us, this manual contains comment and

configuration forms for you to complete. These forms are in Appendix E,

Customer Communication, at the end of this manual.
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Introduction

1
Chapter

This chapter explains how to use this manual, lists what you need to get

started and optional equipment you can order, and briefly describes the

serial hardware and the NI Serial software.

How to Use This Manual

Yes

No

Chapter 2

Chapter 3

Write Application Program

Passes?

Gather What You Need
to Get Started

Chapter 1

Install the NI Serial
Software

Learn About Transceiver
Control Modes

Review Programming
Requirements

Install the Serial Hardware

Configure the Serial Port

Verify the Installation

Connect the Cables

Troubleshooting

Chapter 4
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What You Need to Get Started

Make sure you have all of the items listed before you attempt to install

the serial hardware.

❑ One of the following, which is included in your kit:

AT-232 (two or four port)

AT-485 (two or four port)

AT-232 (two or four port) Isolated

AT-485 (two or four port) Isolated

PCMCIA-232 (one or two port)

PCMCIA-485 (one or two port)

❑ 3.5 in. high density disk (1.44 MB) NI Serial Software for

Windows 95 and Windows NT, which is included in your kit

❑ Microsoft Windows NT version 4.0 or higher installed on your

computer

If you have a four-port isolated interface, you also need a 10-position

modular jack to DB-9 cable, which is included in your kit.

Optional Equipment

Call National Instruments for more information about the following

optional equipment.

• DB-9 RS-485 termination connector (AT-485 and PCMCIA-485

interfaces only)

• 10-position modular jack to DB-9 cable (four-port interfaces only)

• 10-position modular jack to DB-25 cable (four-port interfaces only)

• RS-232 9-pin to 9-pin null modem cable

• RS-232 9-pin to 25-pin null modem cable

Serial Hardware Overview

The serial hardware gives you a variety of solutions for serial

communications. The AT-232 and PCMCIA-232 interfaces work with
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the RS-232 protocols, and the AT-485 and PCMCIA-485 interfaces work

with the RS-422 and RS-485 protocols. You can use the AT-232 or

PCMCIA-232 hardware for serial communication up to distances of 50 ft.

Using serial cable lengths up to 4,000 ft., you can connect the AT-485 or

PCMCIA-485 hardware with up to 31 devices.

The AT boards are available in three different versions:

• All ports on the board share the same IRQ.

• Each port requires a separate IRQ. (This version does not ship with

the NI Serial software for Windows NT.)

• All ports on the board are isolated and share the same IRQ.

Additionally, the AT-232 and AT-485 boards are available in a two-port

version (AT-232/2 and AT-485/2) or a four-port version (AT-232/4 and

AT-485/4). The two-port versions use DB-9 connectors. The four-port

versions use 10-position modular jacks to provide all four connections on

a single back panel. Optional cable accessories convert the 10-position

modular jacks to either DB-9 or DB-25 connectors with standard pinouts.

Throughout this manual, references to AT-232 and AT-485 generally refer

to either version.

The isolated AT-232 and AT-485 boards are designed for applications in

harsh environments. The isolated ports provide reliable communication in

situations where non-isolated ports could not because of ground loops

from different ground levels or high common mode voltage induced on

the lines in noisy environments. The isolation between each

communication port and the host PC ensures safe operation of the PC and

the devices connected to other ports on the same board in case of

accidental high voltages on communication lines.

The PCMCIA-232 and PCMCIA-485 cards are available in a one-port

version or two-port version (PCMCIA-232/2 and PCMCIA-485/2).  All

PCMCIA cards come with cables for each port that terminates in a

standard DB-9 D-Sub connector.  Throughout this manual, references to

PCMCIA-232 and PCMCIA-485 generally refer to either version.

The AT-485 and PCMCIA-485 interfaces support four hardware

transceiver control modes for reliable communication with two-wire and

four-wire devices. Refer to Chapter 4, Using Your Serial Hardware, for

more information about transceiver control modes.

All of the serial hardware uses standard 16550-compatible UARTs

(Universal Asynchronous Receiver/Transmitters) for 100% compatibility
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with standard PC COM ports. The serial hardware contains FIFOs

(First-In-First-Out buffers) for reduced susceptibility to interrupt latency

and faster transmission rates. Full Plug and Play compatibility gives you

the convenience of switchless configuration and installation. Refer to

Appendix A, Specifications, for more information about the serial

hardware specifications and operating conditions.

NI Serial Software Overview

The NI Serial software for Windows NT includes a native Windows NT

kernel driver that can provide full interrupt-driven, buffered I/O for

multiple COM ports. Using this driver, you can obtain a maximum baud

rate of 115.2 kbytes/s. The NI Serial software also provides a

configuration utility, which is integrated with the Windows NT Control

Panel. Refer to Appendix A, Specifications, for more information about

software specifications and recommended operating conditions.

The NI Serial software includes the following components:

• Device driver

• Diagnostic test

• Configuration utility

Optional Programming Tools

Your kit includes the NI Serial software for Windows 95 and

Windows NT. In addition, you can order the LabWindows
®
/CVI or

LabVIEW software from National Instruments. LabWindows/CVI and

LabVIEW include instrument driver libraries that make it easier to

communicate with your serial instruments.

LabWindows/CVI is an interactive ANSI C development environment for

building test and measurement and instrument control systems. It

includes interactive code-generation tools and a graphical editor for

building custom user interfaces. It also includes built-in libraries for

IEEE 488.2, VXI, RS-232 control, and plug-in data acquisition. When

you order LabWindows/CVI, you also get hundreds of complete

instrument drivers, which are modular, source-code programs that handle

the communication with your instrument so that you do not have to learn

the programming details.
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LabVIEW is a complete programming environment that departs from the

sequential nature of traditional programming languages and features a

graphical programming environment. It includes all the tools needed for

instrument control, data acquisition, analysis, and presentation.

LabVIEW also includes an extensive instrument driver library.

For more information about LabWindows/CVI and LabVIEW, contact

National Instruments.

Using the Serial Hardware with Other National

Instruments Products

You can use standard serial I/O functions in LabVIEW and

LabWindows/CVI with any National Instruments serial interface, once

you have installed the hardware and software. If you already have

LabVIEW or LabWindows and want to use it with your serial hardware,

refer to your LabVIEW or LabWindows documentation for information

about serial I/O functions.
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Installation and Verification

2
Chapter

This chapter contains instructions to help you install the serial hardware,

NI Serial software, and cables.

Installing the Microsoft PnP ISA Enabler Driver

If you are installing a PCMCIA card, proceed to the next section, Install

the NI Serial Software. If you are installing an AT board, you must install

the PnP ISA Enabler Driver.

The AT serial hardware is Plug and Play. Windows NT 4.0 does not

support Plug and Play. In order for Windows NT to detect and install the

Plug and Play hardware, you must install the PnP ISA Enabler driver

included on your Windows NT 4.0 CD-ROM. Complete the following

steps to install the driver.

1. Locate the Pnpisa.inf file in the Drvlib\Pnpisa\X86 folder on

the Windows NT 4.0 CD-ROM.

3. Right-click on the Pnpisa.inf file, then click Install on the menu

that appears.

3. Restart the computer.

Install the NI Serial Software

Before installing the hardware, complete the following steps to install the

NI Serial software for Windows NT. If you are installing an AT board,

make sure that you have already installed the PnP ISA Enabler driver as

described in the previous section.

1. Log on as Administrator or as a user who has Administrator

privileges.

2. Select Start»Settings»Control Panel.
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3. Double-click on the Add/Remove Programs icon in the Control

Panel to launch the Add/Remove Programs applet. A dialog box

similar to the one in Figure 2-1 appears.

Figure 2-1.  Add/Remove Programs Properties Dialog Box

You can use this same applet to uninstall the NI Serial software at a

later time if you want to.  Refer to Appendix C, Uninstalling the

Serial Hardware and Software, for more information.

4. Click on the Install... button.

5. Insert the NI Serial Software for Windows 95 and Windows NT

(Setup Disk), and click on the Next button to proceed.

6. The software installation wizard begins with the screen shown in

Figure 2-2.
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Figure 2-2.  NI Serial Setup Screen

The setup wizard guides you through the necessary steps to install

the NI Serial software. You may go back and change values where

appropriate by clicking on the Back. You can exit the setup where

appropriate by clicking on the Cancel.

Note: This installation backs up the Microsoft Windows NT serial driver

serial.sys to serial.bak and then overwrites serial.sys.

serial.sys is located in the Windows NT .....\system32\drivers

directory.

The software is installed. Proceed to the next section, Install the Serial

Hardware.

Install the Serial Hardware

Install the PCMCIA Card
To install the PCMCIA-232 or PCMCIA-485 in your computer, complete

the following steps.

1. Shut down the computer.
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2. Insert the card into a free PC Card (PCMCIA) socket the same way

you insert a disk into a floppy drive. The card has no jumpers or

switches to set.

3. Power on the computer and start Windows NT.

Figure 2-3 shows how to insert a PCMCIA serial card and how to

connect the cable.

PCMCIA Socket

Portable

Computer

  N
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NAL
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S TRUMENTS

®
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PCMCIA Serial Cable
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Figure 2-3.  Inserting a PCMCIA Serial Card

Proceed to the next section, Select Resources for the PCMCIA Card.

Select Resources for the PCMCIA Card
Complete the following steps to select resources for your PCMCIA card.

1. Select Start»Settings»Control Panel.

2. Double-click on the niports icon.

3. Select the PCMCIA card you just installed from the Add a New

PCMCIA Card list, and click on the Add button.
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4. In the Resource Configuration dialog box, select nonconflicting

base I/O address and IRQ settings for your port/card, and click on

OK.

For more information on selecting resources for your port/card, refer

to the Resource Settings section in Chapter 3, Configuration.

5. Exit niports and restart the computer.

After you have selected resources for your PCMCIA card, proceed to the

Verify the Installation section, later in this chapter.

Install the AT Serial Board
Follow these steps to install an AT serial board.

Note: If you are installing an AT-485, you may need to adjust the value of the

bias resistors, depending on your application. For more information,

refer to Appendix B, Serial Port Information.

1. Turn off your computer. Keep the computer plugged in so that it

remains grounded while you install the AT serial board.

2. Remove the top or side cover of the computer.

3. Remove the expansion slot cover on the back of the computer.

4. Insert the AT serial board into an unused slot with the serial

connectors sticking out of the opening on the back panel. Make sure

that you insert the board all the way into the slot. The board may

seem to click firmly into place, even though it is only part of the way

in. Figure 2-4 shows the installation of an AT serial board.
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Figure 2-4.  AT Serial Board Installation

5. Screw the mounting bracket of the AT serial board to the back panel

rail of the computer.

6. Replace the cover, and turn on your computer.

7. Windows NT displays one or more New Hardware Found dialog

boxes, depending on your serial hardware. In each dialog box, make

sure that Windows Default Driver is selected, and click on OK.

8. The serial configuration software displays a PnP Port

Configuration dialog box. Select a nonconflicting base I/O address

and IRQ setting for the port/card, and click on OK. For more

information on selecting resources for your post/card, refer to the

Resource Settings section of Chapter 3, Configuration.

9. After you have selected the resources for all ports, choose to restart

the computer when the system prompts you.

Your serial hardware is now installed.
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Verify the Installation

Determine Which Physical Port Is Associated with COMx
Select Start»Settings»Control Panel, and double-click on niports. A

list of National Instruments ports installed, along with their logical COMx

names, appears. If your interface is not on the list, refer to Appendix D,

Troubleshooting and Common Questions.

Select the COM port you are interested in and click on the Settings

button to display the General Port Settings dialog box for that port. This

dialog box displays the serial number of the serial hardware and the

physical port number starting at 1. On all serial hardware, PORT1 refers

to the top port, PORT2 refers to the next port down, and so on. On newer

hardware the physical ports are labeled PORT1, PORT2, and so on.

When you have finished verifying the driver installation and physical

port, proceed to the next section, Run the Diagnostic Test.

Run the Diagnostic Test
To verify and test the installation, run the diagnostic program that came

with your NI Serial software. The diagnostic program verifies that your

serial driver is installed properly, that the configuration of your hardware

does not conflict with anything else in your system, and that the serial

driver can communicate with your hardware correctly.

To run the test, select the diagnostics item under

Start»Programs»NI Serial Software for Windows NT.

If the diagnostic test completes with no failures, your serial hardware and

software are installed properly. If it fails, refer to Appendix D,

Troubleshooting and Common Questions, for troubleshooting

instructions.
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Connect the Cables

For the PCMCIA serial cards or two-port AT serial boards, you can use

the standard DB-9 connector found on most serial cables. To use the

DB-9 connector with the four-port AT serial boards, you need the

10-position modular jack to DB-9 cable available from National

Instruments. This cable is included with the isolated four-port kits. You

can also use a DB-25 connector with the four-port AT serial boards by

ordering the 10-position modular jack to DB-25 cable from National

Instruments.

Note: To achieve the specified isolation voltage for four-port isolated AT

boards, use ONLY the 10-position modular jack to DB-9 cable included in

your four-port isolated AT serial board kit.

Figure 2-5 and Table 2-1 give the pin locations and descriptions of the

DB-9 connector, which is found on the two-port AT serial board, the

10-position modular jack to DB-9 cable, and the PCMCIA serial cable.

PIN 1

PIN 9
PIN 5

PIN 6

Figure 2-5.  DB-9 Connector Pin Locations
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Table 2-1.  DB-9 Pin Descriptions

DB-9 Pin 232 Signal 485 Signal

Pin 1 DCD* GND

Pin 2 RXD CTS+ (HSI+)

Pin 3 TXD RTS+ (HSO+)

Pin 4 DTR* RXD+

Pin 5 GND RXD-

Pin 6 DSR* CTS- (HSI-)

Pin 7 RTS RTS- (HSO-)

Pin 8 CTS TXD+

Pin 9 RI* TXD-

* These signals are not supported by the isolated 232 ports.

Figure 2-6 and Table 2-2 give the pin locations and descriptions of the

10-position modular jack, which is found on the four-port AT serial

board.

Pin 10Pin 1

Figure 2-6.  10-Position Modular Jack Pin Locations
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Table 2-2.  10-Position Modular Jack Pin Descriptions

10 Position

Modular Jack AT-232 Signal AT-485 Signal

Pin 10 DCD* GND

Pin 9 RXD CTS+ (HSI+)

Pin 8 TXD RTS+ (HSO+)

Pin 7 DTR* RXD+

Pin 6 GND RXD-

Pin 5 DSR* CTS- (HSI-)

Pin 4 RTS RTS- (HSO-)

Pin 3 CTS TXD+

Pin 2 RI* TXD-

Pin 1 No Connect No Connect

* These signals are not supported by the isolated 232 ports.

Figure 2-7 and Table 2-3 give the pin locations and descriptions of the

DB-25 connector, which is on the optional 10-position modular jack to

DB-25 cable.

PIN 1

PIN 25
PIN 13

PIN 14

Figure 2-7.  DB-25 Connector Pin Locations
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Table 2-3.  DB-25 Pin Descriptions

DB-25 Pin AT-232 Signal AT-485 Signal

Pin 2 TXD RTS+ (HSO+)

Pin 3 RXD CTS+ (HSI+)

Pin 4 RTS RTS- (HSO-)

Pin 5 CTS TXD+

Pin 6 DSR* CTS- (HSI-)

Pin 7 GND RXD-

Pin 8 DCD* GND

Pin 20 DTR* RXD+

Pin 22 RI* TXD-

Pins not listed in this table are No Connect.

* These signals are not supported by the isolated 232 ports.

Figure 2-8 shows how to connect the cables when you install a four-port

version of the AT serial board.

AT Serial Board

Additional 

Serial Cable

Additional 

Serial Cable

10-position modular jack 

to DB-9 cable

10-position modular jack

 to DB-25 cable

485 Terminator

(AT-485 only)

Figure 2-8.  Connecting the Cables to Your Four-Port AT Serial Board
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Connecting Two-Wire Devices

The AT-485 boards and PCMCIA-485 cards are designed to work with

either two- or four-wire devices. If you are using a two-wire device, refer

to the device’s documentation for specific wiring instructions.

In general, half-duplex networks use a single twisted pair of wires for

communication in both directions, so you must connect both the

transmitter and the receiver at each end of the same pair of wires. For

example, to connect an RS-485 data acquisition device to a port on your

AT-485 using half-duplex communication, you need a single twisted pair

of wires. At the AT-485, you should connect the TXD+ and RXD+

signals (pins 8 and 4 on a DB-9 connector, pins 5 and 20 on a DB-25

connector) together and to one wire. You should connect the other end of

this wire to both the TXD+ and RXD+ signals on the data acquisition

device. You use the same method to connect the TXD- and RXD- signals

(pins 9 and 5 on a DB-9 connector, pins 22 and 7 on a DB-25 connector)

to the second wire.

Refer to Chapter 4, Using Your Serial Hardware, for information on

setting the transceiver mode for two-wire communication. Refer to

Appendix B, Serial Port Information, for more information on duplex

architectures.
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Configuration

3
Chapter

This chapter contains instructions to help you view or change the

communication port settings.

Change/View Communication Port Settings

The serial configuration utility is fully integrated with the Windows NT

Control Panel. You can use it to examine or modify the configuration of

the serial port.

Follow these steps to configure the serial port.

1. Select Start»Settings»Control Panel and double-click on the

niports icon. A list of National Instruments ports appears, as shown

in Figure 3-1.

Figure 3-1. niports Configuration Utility
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2. Select the port you are interested in.

3. Click on the Settings button to view or configure the port settings.

Refer to the next section, General Port Settings, for more

information.

4. Click on the Resources button in the General Port Settings dialog

box to view or configure the resources for the port. Refer to the

Resource Settings section, later in this chapter, for more information.

5. Click on Delete to remove the port.

6. Click on Add to configure resources for a new PCMCIA card.

General Port Settings

This section describes the options you can set in the General Port

Settings dialog box, shown in Figure 3-2.

Figure 3-2.  General Port Settings Dialog Box

COM Port Number
You can use the COM Port Number control to change the COMx name

of the port selected.



Chapter 3    Configuration

© National Instruments Corporation 3-3 Serial for Windows NT

Transceiver Mode
The transceiver mode selection shows the transceiver mode in use, and

applies only to AT-485 boards and PCMCIA-485 cards. Refer to

Chapter 4, Using Your Serial Hardware, for more information about

transceiver modes. If you use two-wire TXRDY mode, FIFOs must be

enabled.

FIFO Enabled
You can use the FIFO Enabled control to enable or disable the FIFO

buffers on the serial port. FIFO buffers are present on the

16550-compatible UARTs—one for the transmitter and one for the

receiver.

Resources
Click on the Resources button to display the resource configuration

dialog box for the port. For more information on resource configuration,

refer to the next section, Resource Settings.

Resource Settings

The following sections explain the resource configuration options for

each serial interface.

PCMCIA-232, PCMCIA-485
Figure 3-3 shows the resource configuration dialog box for a

PCMCIA-485. The PCMCIA-232 dialog box is similar.
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Figure 3-3. Resource Configuration Dialog Box for the PCMCIA-485

Base I/O Address: The base I/O address assigned to the 

port.

IRQ: The IRQ assigned to the port.

PCMCIA-232/2, PCMCIA-485/2
These cards require two base I/O settings, one for each port, and they

share an IRQ.

Figure 3-4 shows the resource configuration dialog box for a

PCMCIA-485/2. The PCMCIA-232/2 dialog box is similar.
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Figure 3-4. Resource Configuration Dialog Box for the PCMCIA-485/2

Base I/O Address: The base I/O addresses assigned to the 

two ports.

IRQ: The IRQ shared by the two ports.

Note: When you select resources for the PCMCIA cards, use the Microsoft

Windows NT diagnostics utility to make sure that the resources have not

been assigned to any other device. This utility displays a list of I/O port

addresses and IRQ levels that are currently being used in your system.

AT Boards (Shared IRQ)
Figure 3-5 shows the PnP Port Configuration dialog box for an

AT-232/4 with shared IRQ. The dialog boxes for other shared IRQ AT

boards are similar.
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Figure 3-5.  PnP Port Configuration Dialog Box for the AT-232/4

Each shared IRQ AT board requires multiple base I/O settings (one for

each port) and one IRQ that is shared between the ports.

Input/Output Range: Each Input/Output Range listing 

displays the I/O address ranges 

assigned to the corresponding port on 

the board.

Interrupt Request: The IRQ shared between the ports on 

the board.

Note: The niports utility informs you if your resources conflict with the

resources of any other interface in the system. It does not check for

conflicts with ports on the same board. Make sure to assign resources

that do not conflict with those assigned to another port on the same

board.
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Note: If you are unable to change the base I/O address by double-clicking on

the Input/Output Range control, select a different Basic Configuration

in the Setting based on: control.

AT Boards (Non-Shared IRQ)
Each port on the board requires one I/O window and one IRQ.

Input/Output Range: The base I/O address range assigned to 

the port.

IRQ: The IRQ assigned to the port.

Note: The niports utility informs you if your resources conflict with the

resources of any other interface in the system. It does not check for

conflicts with ports on the same board. Make sure to assign resources

that do not conflict with those assigned to another port on the same

board.

Note: If you are unable to change the base I/O address by double-clicking on

the Input/Output Range control, select a different Basic Configuration

from the Setting based on: control.
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Using Your Serial Hardware

4
Chapter

This chapter describes how to set the hardware transceiver control mode

for your RS-485 interfaces and lists some general programming

requirements.

Advanced Transceiver Control (AT-485/PCMCIA-485)

The AT-485 boards and PCMCIA-485 cards support four modes of

hardware transceiver control. (Transceiver modes apply only to these

interfaces.) You can use hardware flow control to enable and disable your

transmitters and receivers to work on different bus topologies. Table 4-1

lists the status of the transmitters and receivers under each of the

transceiver control modes.

Table 4-1.  Transceiver Control Modes

Mode Transmitter Receiver

Four-wire mode Always enabled Always enabled

Two-wire mode:

DTR with echo

Enabled with

DTR unasserted

Always enabled

Two-wire mode:

DTR controlled

Enabled with

DTR unasserted

Enabled with

DTR asserted

Two-wire mode:

TXRDY auto control

Enabled with

TXRDY asserted

Enabled with

TXRDY unasserted

Note: Signal names with an overscore, such as DTR , indicate that the signal is

active low.
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Four-Wire Mode
Use the four-wire mode for most full-duplex systems. In this mode, the

transmitter and receiver are always enabled. This mode is the default.

Two-Wire Mode: DTR with Echo
Use this mode in half-duplex systems where the DTR (Data Terminal

Ready) line must control the transmitter. In the DTR-with-echo mode, the

transmitter is tri-stated when the DTR signal of the UART (Universal

Asynchronous Receiver/Transmitter) is asserted. To transmit, your

application must first clear the DTR bit to enable the transmitter. After

the data is fully transmitted, your application once again sets the DTR bit

to disable the transmitter. Because the receiver is always enabled in this

mode, you not only receive packets from other devices, you also receive

the packets sent from your transmitter.

Two-Wire Mode: DTR Controlled
This mode is similar to the two-wire, DTR-with-echo mode. Use this

mode in half-duplex systems where the DTR line must control the

transmitter. Although this mode uses the same method as the

DTR-with-echo mode to control the transmitter, the hardware

automatically disables the receiver whenever the transmitter is enabled.

Thus, you do not receive packets that you have transmitted.

Two-Wire Mode: TXRDY Auto Control
In this mode, the hardware transparently enables the transmitter and

receiver in a two-wire system. This mode removes the burden of flow

control from the user software. By connecting the transmitter to the

TXRDY (Transmit Ready) line, the hardware enables the transmitter for

each byte to be transmitted. Also, the hardware disables the receiver

whenever the transmitter is enabled, so you do not receive packets that

you have transmitted.

Note: It is recommended that you use the two-wire TXRDY auto control mode

when you are communicating with a two-wire device. Because this mode

handles the transmitter/receiver enabling for a two-wire connection in

your hardware, it reduces the software overhead required to perform this

operation in your application program.
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Setting the Transceiver Control Mode
The recommended method for setting the transceiver control mode is

with the serial configuration utility located in the Windows NT Control

Panel. For more information, refer to the General Port Settings section in

Chapter 3, Configuration. The mode you select in the Control Panel is

automatically configured when you open a port on a serial interface. You

can also set the hardware transceiver control mode from within a DOS

application. For each port you want to control, write the control byte for

the mode you want to select to the scratch register of the UART.

Table 4-2 shows the control bytes for each mode.

Table 4-2.  Transceiver Mode Control Bytes

Transceiver Mode Control Byte

Four-wire mode 0x00

Two-wire mode: DTR with echo 0x01

Two-wire mode: DTR controlled 0x02

Two-wire mode: TXRDY auto control 0x03

The scratch register is located at offset 7 from the base address of the

port. For example, if COM2 were located at base address 0x3F8, and you

wanted to set the AT-485 board to two-wire mode with DTR control, you

would write a 0x02 to I/O address 0x3FF. The AT-485 board would

immediately switch to the two-wire mode with DTR control.

Setting the Transceiver Mode with DeviceIoControl
The NI Serial software extends the Windows function

DeviceIoControl for programming the transceiver control mode. To

program the transceiver control mode using DeviceIoControl,

complete the following steps.

1. Add the following lines to your source code.

#include <winioctl.h>

#define IOCTL_SERIAL_SET_TRANSCEIVER_MODE

CTL_CODE(FILE_DEVICE_SERIAL_PORT,37,METHOD_BUFFERED,

FILE_ANY_ACCESS)

2. Use the Win32 function DeviceIoControl. Use the defined control

code value listed in Step 1 to set the transceiver mode, and the input
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buffer values (unsigned long) listed in Table 4-3 for programming

different transceiver modes.

Table 4-3.  DeviceIoControl Function Input Values

Transceiver Mode

DeviceIoControl

Function Input

Value

Four-wire mode 128

Two-wire mode: DTR with echo 129

Two-wire mode: DTR controlled 130

Two-wire mode: TXRDY auto control 131

For example, to set two-wire TXRDY auto control mode, use the

following call:

ULONG TranceiverMode = 131;

DeviceIoControl(hDevice,

IOCTL_SERIAL_SET_TRANSCEIVER_MODE,(PVOID)

&TransceiverMode,sizeof(ULONG),lpOutBuffer,

nOutBufferSize,lpBytesReturned,lpOverlapped);

General Programming Requirements

Once installed, the NI Serial software is integrated into the standard

Windows NT communications software. NI serial ports are used like any

other Windows NT communications (COM) port. Windows NT has

standard communication functions for use within either 16-bit (Win16)

applications or 32-bit (Win32) applications.

Setting the Maximum Baud Rate for a 16-Bit Application
To select 115,200 baud from a 16-bit (Win16) application written in C,

you should define the following constant in your program as follows:

#define CBR_115200 0xff20

You can then use this constant as you would any other baud rate value in

your Windows communication calls. For example, you can place it into a

DCB structure and pass it to SetCommState. For a Win32 application,

do not use the constant shown here for 115,200 baud. Use the constant

defined in the Win32 communications header file provided with your

compiler.
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Other Programming Points
As you begin developing your application, remember that you must use

the standard Microsoft Windows serial communication functions. For

information about Microsoft Windows serial communication functions,

refer to the Win32 Software Development Kit, Online help for Win32

Overviews and Win32 Reference.

If you have LabVIEW or LabWindows and want to use it with your serial

hardware, refer to your LabVIEW or LabWindows documentation for

information about serial I/O functions.
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Specifications

A
Appendix

This appendix describes the characteristics of the serial hardware and the

NI Serial software, along with the recommended operating conditions.

Hardware Specifications

Table A-1.  Physical Characteristics of the Two-Port AT Serial Boards

Characteristic Specification

Dimensions 10.67 by 16.51 cm

(4.2 by 6.5 in.)

I/O Connector DB-9

Power Requirement

(from PC AT I/O channel)

AT-485/2

AT-232/2

AT-485/2 (Shared IRQ)

AT-232/2 (Shared IRQ)

+5 VDC 390 mA  Typical

510 mA  Maximum

+5 VDC 260 mA  Typical

340 mA  Maximum

+5 VDC 140 mA  Typical

180 mA  Maximum

+5 VDC  70 mA  Typical

100 mA  Maximum
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Table A-2.  Physical Characteristics of the Two-Port Isolated AT Serial Boards

Characteristic Specification

Dimensions 10.67 by 18.70 cm

(4.2 by 7.4 in.)

I/O Connector DB-9

Isolation Voltage

From Port to Port

From Any Port to Host

Computer

3000 Vrms/60s

2000 Vrms/60s

Power Requirement

(from PC AT I/O channel)

AT-485/2 Isolated

AT-232/2 Isolated

+5 VDC 220 mA  Typical

260 mA  Maximum

+5 VDC 160 mA  Typical

200 mA  Maximum

Table A-3.  Physical Characteristics of the Four-Port AT Serial Boards

Characteristic Specification

Dimensions 10.67 by 16.51 cm

(4.2 by 6.5 in.)

I/O Connector* 10-position modular jack

Power Requirement

(from PC AT I/O channel)

AT-485/4

AT-232/4

AT-485/4 (Shared IRQ)

AT-232/4 Shared IRQ

+5 VDC 160 mA Typical

200 mA Maximum

+5 VDC 110 mA Typical

150 mA Maximum

+5 VDC 160 mA Typical

200 mA Maximum

+5 VDC 110 mA Typical

150 mA Maximum

* The four-port AT serial board requires a cable to convert the

10-position modular jack to either DB-9 or DB-25 connectors.
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Table A-4.  Physical Characteristics of the Four-Port Isolated AT Serial Boards

Characteristic Specification

Dimensions 10.67 by 25.40 cm

(4.2 by 10.0 in.)

I/O Connector* 10-position modular jack

Isolation Voltage

From Port to Port

From Any Port to Host

Computer

3000 Vrms/60s

2000 Vrms/60s

Power Requirement

(from PC AT I/O channel)

AT-485/4 Isolated

AT-232/4 Isolated

+5 VDC 300 mA Typical

360 mA Maximum

+5 VDC 280 mA Typical

320 mA Maximum

* The four-port isolated AT serial board requires cables, which are

included in your kit, to convert the 10-position modular jack to a

DB-9 connector. Use only the types of cables provided in your kit.

Table A-5.  Physical Characteristics of the PCMCIA Serial Cards

Characteristic Specification

Dimensions 85.6 cm by 54.0 cm by 5.0 mm

(3.370 by 2.126 by 0.197 in.)

I/O Connector Special Cable with DB-9 Dsub

Connector and 15-Pin Converter for PC

Card

Power Requirement

(from PCMCIA expansion

slot)

PCMCIA-232

PCMCIA-485

PCMCIA-232/2

PCMCIA-485/2

+5 VDC 40 mA  Typical

+5 VDC 100 mA  Typical

+5 VDC 60 mA  Typical

+5 VDC 100 mA  Typical
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Table A-6.  Environmental Characteristics of the Serial Hardware

Characteristic Specification

Operating Environment

Component Temperature

Relative Humidity

0° to 40° C

10% to 90%, noncondensing

Storage Environment

Temperature

Relative Humidity

-20° to 70° C

5% to 90%, noncondensing

EMI

AT Serial

AT Serial Isolated

PCMCIA Serial

FCC Class B Certified

FCC Class A Verified

FCC Class A Verified

Software Specifications

Table A-7.  Software Characteristics

Characteristic Specification

Maximum Serial Transfer

Rate

115,200 bps*

Space Required for NI Serial

Software 1 MB

* Actual speed may vary considerably from speed shown due to

system and instrumentation capabilities.



© National Instruments Corporation B-1 Serial for Windows NT

Serial Port Information

B
Appendix

This appendix discusses the RS-232, RS-422, and RS-485 standards and

explains some of the different issues involved with these types of serial

communication.

RS-232

RS-232, as specified in the ANSI/EIA-232-D Standard, Interface

Between Data Terminal Equipment and Data Circuit-Terminating

Equipment Employing Serial Binary Data Interchange, standardizes

serial communication between computers and between computer

terminals and modems. Most applications use the RS-232 standard for

interfacing peripherals to personal computers. RS-232 uses transmission

lines in which the state of each signal is represented by referencing the

voltage level of a single line to ground. RS-232 was designed for serial

communication up to distances of 50 ft. and with data rates up to 20 kb/s.

However, because of improvements in line drivers and cabling, you can

often increase the actual performance of the bus past the limitations on

speed and distance recommended in the specification.

RS-422

RS-422, as specified in the EIA RS-422-A Standard, Electrical

Characteristics of Balanced Voltage Digital Interface Circuits, defines a

serial interface much like RS-232. However, RS-422 uses balanced (or

differential) transmission lines. Balanced transmission lines use two

transmission lines for each signal. The state of each signal is represented,

not by a voltage level on one line referenced to ground as in RS-232, but

rather by the relative voltage of the two lines to each other. For example,

the TX signal is carried on two wires, wire A and wire B. A logical 1 is

represented by the voltage on line A being greater than the voltage on

line B. A logical 0 is represented by the voltage on line A being less than
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the voltage on line B. Differential voltage transmission creates a signal

that is much more immune to noise as well as voltage loss due to

transmission line effects. Thus, you can use RS-422 for much longer

distances (up to 4,000 ft.) and much greater transmission speeds (up to 10

Mb/s) than RS-232.

RS-485

RS-485, as specified in the EIA-485 Standard, Standard for Electrical

Characteristics of Generators and Receivers for Use in Balanced Digital

Multipoint Systems, expands on the RS-422 standard by increasing the

number of devices you can use from 10 to 32 and by working with half-

duplex bus architectures. Unlike the RS-422 standard, RS-485 addresses

the issue of using multiple transmitters on the same line. RS-485 defines

the electrical characteristics necessary to ensure adequate signal voltages

under maximum load, short-circuit protection, and the ability to

withstand multiple drivers driving conflicting signals at the same time.

Table B-1 lists the features of the RS-232, RS-422, and RS-485

standards.

Table B-1.  RS-232, RS-422, and RS-485 Features

Feature RS-232 RS-422 RS-485

Type of

transmission lines

Unbalanced Differential Differential

Maximum number

of drivers

1 1 32

Maximum number

of receivers

1 10 32

Maximum cable

length

50 ft. 4,000 ft. 4,000 ft.

Maximum data rate 20 kb/s 10 Mb/s 10 Mb/s

Maximum CMV ± 25 V +6 to -.25 V +12 to -7 V

Driver output 5 to 25 V 2 to 6 V 1.5 to 6 V

Driver load >3 kΩ 100 Ω 60 Ω
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Serial Communication Issues

This section explains some serial communication issues, such as duplex

architectures, termination methods, bias resistors, and types of connecting

equipment.

Duplex Architectures
Duplex refers to the means of bandwidth usage in a serial system. The

two common means of bi-directional serial communication are full

duplex and half duplex. Half-duplex communication involves a

transmitter and a receiver connected to each end of the same wire or pair

of wires. Because the same transmission line is used for both sending and

receiving data, devices cannot send data in both directions at the same

time. First, one device transmits over the wire(s) to the receiver of the

second device. When the first device finishes transmitting, both devices

switch the connections from their transmitter to their receiver or vice

versa. The device that was receiving data can then transmit over the line.

In full-duplex communication, the devices use a separate wire (or pair of

wires) for simultaneous transmission in each direction. Thus, there is no

need to switch between transmitting and receiving.

In a differential serial bus (for example, RS-422 or RS-485), a half-

duplex system can transmit and receive over the same twisted pair of

wires. Thus, half-duplex communication is often referred to as two-wire

communications. Likewise, full-duplex communication is often referred

to as four-wire communications, because the full-duplex system uses a

separate pair of wires for communication in each direction.

Full Duplex
A typical full-duplex multidrop bus architecture involves a master-slave

protocol. Only one device, the master, can control access to the bus. All

other devices are slaves. Slave devices must wait for the master to give

them access to the bus. In a typical full-duplex system, one transmission

line connects the bus master’s transmitter to all of the slave receivers. A

second transmission line connects all of the slave transmitters to the bus

master’s receiver. Because in a differential system each transmission line

is composed of two separate wires, a full-duplex system is often referred

to as a four-wire system. Figure B-1 shows a typical full-duplex system.
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Figure B-1.  Typical Full-Duplex System

Half Duplex
A typical half-duplex multidrop bus architecture also involves a

master-slave protocol. In a half-duplex system, all transmitters and

receivers are connected to the same transmission line. A half-duplex

system is often referred to as a two-wire system. Figure B-2 shows a

typical half-duplex system.
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Figure B-2.  Typical Half-Duplex System
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Termination
Because each differential pair of wires is a transmission line, you must

properly terminate the line to prevent reflections. A common method of

terminating a two-wire multidrop RS-485 network is to install

terminating resistors at each end of the multidrop network. If you

daisy-chained multiple instruments together, you need a terminating

resistor at only the first and last instruments. The terminating resistor

should match the characteristic impedance of the transmission line

(typically 100−120 Ω). National Instruments offers an optional

DB-9 RS-485 termination connector that contains embedded terminating

resistors for easy termination.

Figure B-3 shows a multidrop network using terminating resistors.

M
A

S
T

E
R

Slave 1

100 Ω

Slave 2 Slave n

100 Ω

Tx

Tx
Rx

Tx
Rx

Tx
Rx

Rx

Figure B-3.  Multidrop Network Using Terminating Resistors

Bias Resistors
A transmission line enters an indeterminate state if no nodes are

transmitting on it. This indeterminate state can cause the receivers to

receive invalid data bits from noise picked up on the cable. To prevent

these data bits, you should force the transmission line into a known state.

By installing two 620 Ω bias resistors at one node on the transmission

line, you can create a voltage divider that forces the voltage between the

differential pair to be less than 200 mV, the threshold voltage for the

receiver. You should install these resistors on only one node.
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Figure B-4 shows a transmission line using bias resistors.

620 Ω
Bias Resistor

+5

A

Tx

B

620 Ω
Bias Resistor

100 Ω
Termination Resistor

Figure B-4.  Transmission Line Using Bias Resistors

Rather than using two 620 Ω resistors at one node, you can also increase

the value of the resistors and put them at every node. For instance, if

there are eight nodes in a system, you can use 4.7 kΩ resistors at each

node to effectively achieve the same result.

DTE vs. DCE
Data Terminal Equipment (DTE) and Data Communications Equipment

(DCE) were the terms used in the RS-232 specification for the types of

equipment on either end of a serial connection. (A DCE is called Data

Circuit-Terminating Equipment in Revision D of the RS-232

specification.)  In general, DTE and DCE refer to computer equipment

and modems, respectively. Because the RS-232 specification mainly

involves connecting a DTE directly to a DCE and vice versa, the pinouts

are defined so that cabling is simple. That is, a cable connected a

computer to a modem by wiring pin 1 to pin 1, pin 2 to pin 2, and so on.

This method is commonly known as straight-through cabling.
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Figure B-5 shows straight-through cabling in a DTE-to-DCE interface.

Pin 2
Rx D

Tx D

Rx D

Tx D

Pin 2 Pin 2

Pin 3Pin 3Pin 3Pin 3

Pin 2
DTE DCE DCE DTE

Figure B-5.  Straight-Through Cabling in a DTE-to-DCE Interface

Straight-through cabling is still the standard method to connect a modem

to your PC. However, because many applications use serial

communication to connect two or more DTEs without modems, the

cabling becomes more complicated. If two DTEs are wired together using

a straight-through cable, one transmitter is connected to the other

transmitter, and one receiver is connected to the other receiver. In this

setup, no transmissions can occur. Thus, these applications must use a

cabling scheme that connects the transmitter on one device to the receiver

on the other device and vice versa. This method is known as null-modem

cabling, because it replaces the two modems that traditional RS-232

applications would require between the two DTEs. You should use a

null-modem cable to communicate from one  serial port to another.

Figure B-6 shows null-modem cabling in a DTE-to-DCE interface.

Rx D

Tx D

Rx D

Tx D

Pin 2

Pin 3Pin 3

Pin 2
DTE DTE

Figure B-6.  Null-Modem Cabling in a DTE-to-DCE Interface
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Uninstalling the Serial

Hardware and Software
C

Appendix

This appendix explains how to uninstall your serial hardware and

NI Serial software.

Removing the Hardware Information

Before physically removing the serial hardware from the computer, you

must remove the hardware information from the Windows NT Control

Panel.

Follow these steps to uninstall the hardware.

1. Double-click on the niports icon under Start»Settings»Control

Panel.

2. Select the port to remove from the list of ports as shown in

Figure C-1.
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Figure C-1.  Selecting an Interface to Uninstall

3. Click on the Delete button.

Note: For shared IRQ AT boards and two-port PCMCIA cards, all ports on the

interface are removed.

Uninstalling the NI Serial Software

Before uninstalling the software, you should remove all serial port

information from the Windows NT Control Panel, as described in the

previous section. You do not need to shut down Windows NT before

uninstalling the software.

Complete the following steps to remove the NI Serial software.

1. Select Start»Settings»Control Panel.

2. Double-click on the Add/Remove Programs icon in the Control

Panel to launch the Add/Remove Programs applet. A dialog box

similar to the one in Figure C-2 appears. This dialog box lists the

software available for removal.
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Figure C-2.  Add/Remove Programs Properties Dialog Box

3. Select the serial software you want to remove, and click the

Add/Remove... button. The uninstall program runs and removes all

folders, utilities, and registry entries associated with the NI Serial

software. Figure C-3 shows the results of a successful uninstallation.
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Figure C-3.  Uninstallation Results

4. Shut down Windows NT, power off your computer, and remove

your serial interfaces now.

If you want to reinstall the hardware and software, refer to Chapter 2,

Installation and Verification.
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Troubleshooting and

Common Questions

D
Appendix

This appendix describes how to troubleshoot problems and answers some

common questions.

Missing Serial Port in the niports List

The serial configuration utility niports contains configuration

information for serial hardware it is aware of that is installed in your

system.

To start the configuration utility, select Start»Settings»Control Panel,

and double-click on the niports icon.

If you are using an AT board, make sure you have installed the Microsoft

PnP ISA Enabler driver. niports cannot recognize the AT boards without

the Microsoft PnP ISA Enabler driver. For more information, refer to the

Installing the Microsoft PnP ISA Enabler Driver section of Chapter 2,

Installation and Verification.

Resolving Resource Conflicts

Resource conflicts occur when your system contains hardware that is

configured to use the same resources as your serial interface. The serial

driver detects some resource conflicts when it loads. When the driver

detects conflicts as it loads, it records an error message describing the

conflict. You can use the Event Viewer to see which resource is in

conflict. To run the Event Viewer, select

Start»Programs»Administrative Tools»Event Viewer.

After you have identified the resource that caused the conflict, use the

serial configuration utility, niports, to reconfigure your serial interface so
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that it uses conflict-free resources. For more information, refer to

Chapter 3, Configuration.

To help in the selection of conflict-free resources, Microsoft has provided

a utility called Windows NT Diagnostics. This utility displays a list of the

I/O port addresses, IRQ levels, and DMA channels that are currently

being used in your system. Assign resources not listed by this utility to

your serial interface.

To run the Windows NT Diagnostics, select

Start»Programs»Administrative Tools»Windows NT Diagnostics.

Troubleshooting Diagnostic Messages

This section lists possible diagnostic error messages, along with

solutions.

No National Instruments serial port found

If this error message appears, refer to Chapter 2, Installation and

Verification, to follow these troubleshooting steps:

1. Verify the hardware resources.

2. Verify that the National Instruments serial driver is installed.

3. If either the serial hardware or serial.sys file is missing, reinstall

the hardware and software.

Lesser number of ports found than expected

If this error message appears, refer to Chapter 2, Installation and

Verification, to follow these troubleshooting steps:

1. Verify the hardware resources.

2. Verify that the National Instruments serial driver is installed.

3. Check the hardware installation to make sure the correct number of

boards/ports are installed.

I/O address test failed, Interrupt test cannot be

performed.

If this error message appears, verify the hardware resources as described

in Chapter 3, Configuration. If the test still fails, you probably have an

I/O address conflict with legacy boards in your system. Use the niports

configuration utility to change the base I/O addresses assigned to your

ports. For more information, refer to Chapter 3, Configuration.
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Interrupt test failed

If this error message appears, verify the hardware resources as described

in Chapter 3, Configuration. If the test still fails, you probably have an

IRQ conflict with legacy boards in your system. Use the niports

configuration utility to change the IRQ level assigned to your port. For

more information, refer to Chapter 3, Configuration.

Common Questions

How can I determine which type of serial hardware I have installed?

Double-click on the niports icon under Start»Settings»Control Panel to

display a list of installed ports.

What do I do if the diagnostic test fails with an error?

Refer to the troubleshooting sections of this manual for specific

information about what might cause the test to fail.

How can I determine which port is associated with COMx?

Refer to the section Determine Which Physical Port is Associated with

COMx, in Chapter 2, Installation and Verification.

How can I name National Instruments serial ports COM1, COM2,

COM3, or COM4?

Refer to the General Port Settings section in Chapter 3, Configuration.

What information should I have before I call National Instruments?

When you call National Instruments, you should have the results of the

Diagnostic test. Also, make sure you have filled out the hardware and

software configuration form in Appendix E, Customer Communication.
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Customer Communication

E
Appendix

For your convenience, this appendix contains forms to help you gather the information necessary to
help us solve technical problems you might have as well as a form you can use to comment on the
product documentation. Filling out a copy of the Technical Support Form before contacting
National Instruments helps us help you better and faster.

National Instruments provides comprehensive technical assistance around the world. In the U.S. and
Canada, applications engineers are available Monday through Friday from 8:00 a.m. to 6:00 p.m.
(central time). In other countries, contact the nearest branch office. You may fax questions to us at
any time.

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
files and documents to answer most common customer questions. From these sites, you can also
download the latest instrument drivers, updates, and example programs. For recorded instructions on
how to use the bulletin board and FTP services and for BBS automated information, call
(512) 795-6990. You can access these services at:

United States:  (512) 794-5422

Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635  551422

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use
your Internet address, such as joesmith@anywhere.com, as your password. The support files and
documents are located in the /support directories.



Fax-on-Demand Support

Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
wide range of technical information. You can access Fax-on-Demand from a touch-tone telephone at
(512) 418-1111.

E-Mail Support (currently U.S. only)

You can submit technical support questions to the applications engineering team through e-mail at
the Internet address listed below. Remember to include your name, address, and phone number so
we can contact you with solutions and suggestions.

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical
support number for your country. If there is no National Instruments office in your country, contact
the source from which you purchased your software to obtain support.

Telephone Fax

Australia 03 9879 5166 03 9879 6277

Austria 0662 45 79 90 0 0662 45 79 90 19

Belgium 02 757 00 20 02 757 03 11

Canada (Ontario) 905 785 0085 905 785 0086

Canada (Quebec) 514 694 8521 514 694 4399

Denmark 45 76 26 00 45 76 26 02

Finland 09 725 725 11 09 725 725 55

France 01 48 14 24 24 01 48 14 24 14

Germany 089 741 31 30 089 714 60 35

Hong Kong 2645 3186 2686 8505

Israel 03 5734815 03 5734816

Italy 02 413091 02 41309215

Japan 03 5472 2970 03 5472 2977

Korea 02 596 7456 02 596 7455

Mexico 5 520 2635 5 520 3282

Netherlands 0348 433466 0348 430673

Norway 32 84 84 00 32 84 86 00

Singapore 2265886 2265887

Spain 91 640 0085 91 640 0533

Sweden 08 730 49 70 08 730 43 70

Switzerland 056 200 51 51 056 200 51 55

Taiwan 02 377 1200 02 737 4644

U.K. 01635 523545 01635 523154



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and
use the completed copy of this form as a reference for your current configuration. Completing this
form accurately before contacting National Instruments for technical support helps our applications
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem,
include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Title ___________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

________________________________________________________________________________

Fax ( ____  ) _________________________ Phone ( ____ ) ___________________________

Computer brand ___________________ Model ______________ Processor ________________

Operating system (include version number) ____________________________________________

Clock Speed ________ MHz RAM _________ MB Display adapter ________________

Mouse ____ yes _____ no Other adapters installed _____________________________

Hard disk capacity ________  MB Brand ____________________________________________

Instruments used __________________________________________________________________

National Instruments hardware product model _____________________ Revision ____________

Configuration ____________________________________________________________________

National Instruments software product ___________________________ Version ____________

Configuration ____________________________________________________________________

The problem is ___________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

List any error messages ____________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

The following steps will reproduce the problem _________________________________________

________________________________________________________________________________

________________________________________________________________________________



Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each item.
Complete a new copy of this form each time you revise your software or hardware configuration,
and use this form as a reference for your current configuration. Completing this form accurately
before contacting National Instruments for technical support helps our applications engineers answer
your questions more efficiently.

National Instruments Products

• Serial Hardware and Revision Number

– AT-232 Board Revision                                                                                                             

Two Port                         Four Port                         

or

– AT-485 Board Revision                                                                                                             

Two Port                         Four Port                         

or

– PCMCIA-485 Card Revision                                                                                                     

One Port                         Two Port                         

or

– PCMCIA-232 Card Revision                                                                                                     

One Port                         Two Port                         

• NI Serial Software Revision Number on Distribution Disk                                                          

• Hardware Settings

Base I/O

Address

Interrupt

Level

COM1                                         

COM2                                         

COM3                                         

COM4                                         

COM5                                         

COM6                                         

COM7                                         

COM8                                         

COM9                                         



Other Products

• Computer Make and Model                                                                                                           

• Microprocessor                                                                                                                             

• Clock Frequency                                                                                                                           

• Type of Monitor Card Installed                                                                                                    

• Windows Version                                                                                                                         

• Application Programming Language (Microsoft C, Visual Basic for Windows)                         

                                                                                                                                                       

• Number of Serial Ports in System

 Built In                                     Adapter Cards                                                               

• Other Boards in System                                                                                                                

• Base I/O Address of Other Boards                                                                                                

• Interrupt Level of Other Boards                                                                                                    



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products.
This information helps us provide quality products to meet your needs.

Title: Getting Started with Your Serial Hardware and Software for Windows NT

Edition Date: June 1997

Part Number: 321572A-01

Please comment on the completeness, clarity, and organization of the manual.

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

Thank you for your help.

Name __________________________________________________________________________

Title ___________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

________________________________________________________________________________

Phone ( ____  ) _________________________________________________________________

Mail to: Technical Publications Fax to: Technical Publications

National Instruments Corporation National Instruments Corporation

6504 Bridge Point Parkway (512) 794-5678

Austin, TX 78730-5039
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Glossary

Prefix Meaning Value

m- milli- 10-3

c- centi- 10-2

k- kilo- 103

M- mega- 106

° degrees

% percent

Ω ohms

A amperes

ANSI American National Standards Institute

b bits

baud bits per second

C Celsius

COM Computer Output Microform

DB-xx subminiature D connector (where xx is the number of pins)

DCE Data Communications Equipment or Data Circuit-Terminating

Equipment

DMA direct memory access

DTE Data Terminal Equipment

DTR Data Terminal Ready (where the overscore denotes that the signal is

active low)

EIA Electronic Industries Association

EMI electromagnetic interference

FCC Federal Communications Commission

FIFO first-in-first-out
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ft feet

Hz hertz

IEEE Institute of Electrical and Electronic Engineers

in. inches

I/O input/output

IRQ interrupt request

ISA Industry Standard Architecture

m meters

MB megabytes of memory

PC personal computer

RAM random-access memory

RX Receive

s seconds

TX Transmit

TXRDY Transmit Ready  (where the overscore denotes that the signal is

active low)

UART universal asynchronous receiver/transmitter

V volts

VDC volts direct current


	Getting Started with Your Serial Hardware and Software for Windows NT
	Important Information
	Warranty
	Copyright
	Trademarks
	Warning

	FCC/DOC Radio Frequency Interference Compliance
	Table of Contents
	About This Manual
	Organization of This Manual
	Conventions Used in This Manual
	Related Documentation
	Customer Communication

	Chapter 1 Introduction
	How to Use This Manual
	What You Need to Get Started
	Optional Equipment
	Serial Hardware Overview
	NI Serial Software Overview
	Optional Programming Tools
	Using the Serial Hardware with Other National Instruments Products

	Chapter 2 Installation and Verification
	Installing the Microsoft PnP ISA Enabler Driver
	Install the NI Serial Software
	Install the Serial Hardware
	Install the PCMCIA Card
	Select Resources for the PCMCIA Card

	Install the AT Serial Board

	Verify the Installation
	Determine Which Physical Port Is Associated with COMx
	Run the Diagnostic Test

	Connect the Cables
	Connecting Two-Wire Devices

	Chapter 3 Configuration
	Change/View Communication Port Settings
	General Port Settings
	COM Port Number
	Transceiver Mode
	FIFO Enabled
	Resources

	Resource Settings
	PCMCIA-232, PCMCIA-485
	PCMCIA-232/2, PCMCIA-485/2
	AT Boards (Shared IRQ)
	AT Boards (Non-Shared IRQ)


	Chapter 4 Using Your Serial Hardware
	Advanced Transceiver Control (AT-485/PCMCIA-485)
	Four-Wire Mode
	Two-Wire Mode: DTR with Echo
	Two-Wire Mode: DTR Controlled
	Two-Wire Mode: TXRDY Auto Control
	Setting the Transceiver Control Mode
	Setting the Transceiver Mode with DeviceIoControl

	General Programming Requirements
	Setting the Maximum Baud Rate for a 16-Bit Application
	Other Programming Points


	Appendix A Specifications
	Hardware Specifications
	Software Specifications

	Appendix B Serial Port Information
	RS-232
	RS-422
	RS-485
	Serial Communication Issues
	Duplex Architectures
	Full Duplex
	Half Duplex

	Termination
	Bias Resistors
	DTE vs. DCE


	Appendix C Uninstalling the Serial Hardware and Software
	Removing the Hardware Information
	Uninstalling the NI Serial Software

	Appendix D Troubleshooting and Common Questions
	Missing Serial Port in the niports List
	Resolving Resource Conflicts
	Troubleshooting Diagnostic Messages
	Common Questions

	Appendix E Customer Communication
	Glossary
	Figures
	Figure 2-1. Add/Remove Programs Properties Dialog Box
	Figure 2-2. NI Serial Setup Screen
	Figure 2-3. Inserting a PCMCIA Serial Card
	Figure 2-4. AT Serial Board Installation
	Figure 2-5. DB-9 Connector Pin Locations
	Figure 2-6. 10-Position Modular Jack Pin Locations
	Figure 2-7. DB-25 Connector Pin Locations
	Figure 2-8. Connecting the Cables to Your Four-Port AT Serial Board
	Figure 3-1. niports Configuration Utility
	Figure 3-2. General Port Settings Dialog Box
	Figure 3-3. Resource Configuration Dialog Box for the PCMCIA-485
	Figure 3-4. Resource Configuration Dialog Box for the PCMCIA-485/2
	Figure 3-5. PnP Port Configuration Dialog Box for the AT-232/4
	Figure B-1. Typical Full-Duplex System
	Figure B-2. Typical Half-Duplex System
	Figure B-3. Multidrop Network Using Terminating Resistors
	Figure B-4. Transmission Line Using Bias Resistors
	Figure B-5. Straight-Through Cabling in a DTE-to-DCE Interface
	Figure B-6. Null-Modem Cabling in a DTE-to-DCE Interface
	Figure C-1. Selecting an Interface to Uninstall
	Figure C-2. Add/Remove Programs Properties Dialog Box
	Figure C-3. Uninstallation Results

	Tables
	Table 2-1. DB-9 Pin Descriptions
	Table 2-2. 10-Position Modular Jack Pin Descriptions
	Table 2-3. DB-25 Pin Descriptions
	Table 4-1. Transceiver Control Modes
	Table 4-2. Transceiver Mode Control Bytes
	Table 4-3. DeviceIoControl Function Input Values
	Table A-1. Physical Characteristics of the Two-Port AT Serial Boards
	Table A-2. Physical Characteristics of the Two-Port Isolated AT Serial Boards
	Table A-3. Physical Characteristics of the Four-Port AT Serial Boards
	Table A-4. Physical Characteristics of the Four-Port Isolated AT Serial Boards
	Table A-5. Physical Characteristics of the PCMCIA Serial Cards
	Table A-6. Environmental Characteristics of the Serial Hardware
	Table A-7. Software Characteristics
	Table B-1. RS-232, RS-422, and RS-485 Features


